
  МИНИСТЕРСТВО КУЛЬТУРЫ РОССИЙСКОЙ ФЕДЕРАЦИИ 
Федеральное государственное бюджетное образовательное учреждение высшего 

образования 
«Сибирский государственный институт искусств имени Дмитрия Хворостовского» 

 
Приложение 1 к рабочей программе 

 
 

 
 
 
 
 

ФОНД ОЦЕНОЧНЫХ СРЕДСТВ  
 

для проведения промежуточной аттестации  
по дисциплине  

 
«Современные информационные технологии» 

 
Направление подготовки 

 
53.03.02 Музыкально-инструментальное искусство 

 
Профиль Фортепиано 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Разработчики:  

   
ст. преподаватель Шкредова И.Н. 
ст. преподаватель Гордеева Е.В. 
 

 
 

 



1. Перечень компетенций и планируемых результатов изучения дисциплины. Критерии 
оценивания результатов обучения и оценочные средства. 

 
Компетенции Индикаторы 

компетенций 
Критерии оценивания результатов обучения Оценочные 

средства 1 2 3 4 5 

ОПК-5. 
Способен решать 
стандартные задачи 
профессиональной 
деятельности с 
применением 
информационно-
коммуникационных 
технологий и с 
учетом основных 
требований 
информационной 
безопасности 

 

Знать: 
– основные виды 
современных 
информационно-
коммуникационных 
технологий; 

Отсут
ствие 
знаний 

Фрагментар-
ные знания 
 

Общие, но не 
структурирован-
ные знания 

Сформиро
ванные, но 
содержа-
щие от-
дельные 
пробелы 
знания 

Сформиро
ванные 
системати-
ческие 
знания 

Устный ответ 
Лабораторная 
работа 

Уметь: 
– использовать 
компьютерные 
технологии для 
поиска, отбора и 
обработки 
информации, 
касающийся 
профессиональной 
деятельности; 
применять 
информационно-
коммуникационные 
технологии в 
собственной 
педагогической, 
художественно-

Отсут
ствие 
уме-
ний 

Частично 
освоенное 
умение 

В целом успеш-
ное, но не систе-
матическое 
умение 

В целом 
успешное, 
но содер-
жащее 
пробелы 
умение 

Успешное 
и сис-
тематичес-
кое умение 
 

Устный ответ 
Лабораторная 
работа 



творческой и (или) 
научно-
исследовательской 
деятельности; 
Владеть: 
– навыками 
использования 
информационно-
коммуникационных 
технологий в 
собственной 
профессиональной 
деятельности; 

Отсут
ствие 
навы-
ков 

Фрагментарно
е применение 
навыков 

В целом 
успешное, но не 
систематическое 
применение на-
выков 
 

В целом 
успешное, 
но сопро-
вождаю-
щееся от-
дельными 
ошибками 
при-
менение 
навыков 

Успешное 
и система-
тическое 
примене-
ние 
навыков 

Устный ответ 
Лабораторная 
работа 



2. Шкалы оценивания и критерии оценки 

Устный ответ  

позволяет оценить следующие знания, умения, навыки и/или опыт практической 

деятельности: 

Знать: 

– основные виды современных информационно-коммуникационных технологий; 

Уметь: 

– использовать компьютерные технологии для поиска, отбора и обработки 

информации, касающийся профессиональной деятельности; 

применять информационно-коммуникационные технологии в собственной 

педагогической, художественно-творческой и (или) научно-исследовательской 

деятельности; 

Владеть: 

– навыками использования информационно-коммуникационных технологий в 

собственной профессиональной деятельности; 

 

Критерии оценки устного ответа 

 
критерии оценка  

2  
(неудовлетвори

тельно) 

3  
(удовлетвори-

тельно) 

4  
(хорошо) 

5  
(отлично) 

1. 
Обоснованность
, четкость, 
краткость 
изложения 
ответа. 

Отсутствует 
ориентация в 
материале 
вопроса, 
последовательн
ое изложение и 
логика в 
изложении 
темы. 
Временные 
рамки ответа 
размыты.  

Вопрос 
раскрыт 
частично. 
Допущены 
неточности и 
ошибки при 
толковании 
основных 
положений 
вопроса. 
Ответ затянут 
по времени, 
потребовалис
ь наводящие 
вопросы. 

Ответ достаточно 
уверенный, 
материал изложен 
грамотно, но 
содержание 
вопроса раскрыто 
не в полной мере. 
Ответ затянут по 
времени. 

Обоснованный, 
четкий ответ, 
прослеживается 
логика в 
изложении темы 
и собственный 
взгляд на 
проблему. 
Вопрос раскрыт 
полностью за 
оптимальное 
время. 



 

Лабораторная работа 

позволяет оценить следующие знания, умения, навыки и/или опыт практической 
деятельности: 

Знать: 
– основные виды современных информационно-коммуникационных технологий; 
Уметь: 
– использовать компьютерные технологии для поиска, отбора и обработки 

информации, касающийся профессиональной деятельности; 
применять информационно-коммуникационные технологии в собственной 

педагогической, художественно-творческой и (или) научно-исследовательской 
деятельности; 

Владеть: 
– навыками использования информационно-коммуникационных технологий в 

собственной профессиональной деятельности; 
 

 
 

Критерии оценки качества лабораторных работ: 
 

2. Гибкость 
мышления, 
знание учебной 
и методической 
литературы. 

Отсутствие 
ответов на 
дополнительны
е вопросы. 
Частичные 
знания учебной 
и методической 
литературы 
(менее 40%).  

Большие 
затруднения в 
ответах на 
дополнительн
ые вопросы. 
Избирательно
е знание 
некоторых 
источников 
учебной и 
методической 
литературы 
(не менее 
50%). 

Незначительные 
неточности при 
ответах на 
дополнительные 
вопросы. В 
целом, хорошая 
ориентация в 
учебной и 
методической 
литературе (не 
менее 80%). 

Грамотные и 
содержательные 
ответы на 
дополнительные 
вопросы. 
Эрудированност
ь в знании 
учебной и 
методической 
литературы 
(100%). 

3. Уровень 
владения 
профессиональн
ой 
терминологией. 

Слабая 
ориентация в 
профессиональ
ной терминоло-
гии, неумение 
применить при 
ответе. 

Большие 
затруднения в 
применении в 
ответе про-
фессиональ-
ной термино-
логии. 
Избиратель-
ные знания 
(не менее 
50%). 

Знание основных 
понятий термино-
логии (не менее 
80%). Допущены 
незначительные 
2-4 неточности. 

Уверенное 100% 
владение терми-
нологией. Гра-
мотное 
применение при 
ответе. 

критерии оценка  
2  

(неудов
летворительно) 

3  
(удовл

етворительно) 

4  
(хорошо) 

5  
(отлично) 



 

3. Типовые контрольные задания 
 

ПРИМЕРЫ ВОПРОСОВ ДЛЯ УСТНОГО ОТВЕТА 
 

1. Виды информационных ресурсов.  
2. Что такое информационная безопасность? 
3. Что входит в понятие «дистанционное образование»? 
4. Строение персонального компьютера. 
5. Что входит в понятие «периферийные устройства» ПК? 
6. Операционная система 
7. Типы прикладного программного обеспечения 
8. Имя файла. Формат файла. 
9. Методы и способы защиты информации от несанкционированного доступа. 
10. Определения: гиперссылка, веб-страница, веб-сайт, аккаунт. 
11. Электронная интернет-библиотека, примеры ЭБС. 
12. Какие типы графических редакторов вы знаете? 
13. Растровые графические редакторы 
14. Какие бывают растровые графические программы, чем они отличаются? 
15. Расскажите о векторных графических редакторах.  
16. Для каких целей лучше применять растровые графические программы, и для каких 

– векторные? 
17. Что такое шаблон документа? Какие задачи позволяет решить использование 

шаблонов? 
18. Какие параметры шрифта используются в форматировании текста? 
19. Как можно описать геометрию абзаца? 
20. Что такое колонтитулы и как они оформляются? 
21. Как создать автособираемое оглавление? 
22. Какие непечатные знаки используются в текстовых редакторах? 

1.Оформ
ление работы с 
точки зрения 
форматирования 

Работа 
не 
отформатирова
на  

Допущ
ены 
неточности и 
ошибки при 
форматиро-
вании. Разные 
фрагменты 
имеют разный 
формат. 

В тексте 
встречаются 
элементы разного 
формата 

Работа 
отформатирован
а в соответствии 
с требованиями 

2. 
Правильное 
программное 
оформление 
структуры 
работы 

Отсутст
вие структуры 
как таковой  

Структ
ура работы 
оформлена 
без 
применения 
программных 
методов 

При 
программном 
оформлении 
структуры 
допущены 
ошибки 

Структур
а оформлена при 
помощи 
программных 
методов в 
соответствии с 
требованиями 

3. 
Правильность 
оформления 
списков, ссылок 
и т.д.. 

Списки 
и ссылки не 
оформлены 

Допущ
ены грубые 
ошибки при 
оформлении 
ссылок и 
списков 

Допущены 
незначительные 
ошибки при 
оформлении 
ссылок и списков 

Уверенно
е 100% владение 
методикой 
оформления 
списков и 
ссылок 



23. Excel: что такое рабочая книга, рабочий лист, строка, столбец и ячейка рабочего 
листа? 

24. Что такое строка формул? Какие задачи позволяет решать использование формул? 
25. Что такое Диапазон и как он оформляется в Excel? Какие задачи позволяет решить 

использование Диапазона? 
26. Какие типы данных используются в Excel? 
27. Для чего используется знак “$” в адресации ячеек? 
28. Что такое Автозаполнение и для чего оно используется в табличном процессоре? 
29. Что такое функция? Какие виды функции используются в Excel? 

 
ПРИМЕРЫ ЛАБОРОТОРНЫХ РАБОТ  

 
Лабораторная работа №1. (Excel) 
Основные приемы работы с электронными таблицами 

 

Упражнение 1 
Введение основных понятий, связанных с работой электронных таблиц 

Excel. 
1. Запустите программу Microsoft Excel, любым, известным вам способом. 

Внимательно рассмотрите окно программы Microsoft Excel. Первый взгляд на 
горизонтальное меню и панели инструментов несколько успокаивает, так как многие 
пункта горизонтального меню и кнопки панелей инструментов совпадают с пунктами 
меню и кнопками окна редактора Word. 

Совсем другой вид имеет рабочая область и представляет из себя размеченную 
таблицу, состоящую из ячеек одинакового размера. Одна из ячеек явно выделена 
(обрамлена черной рамкой). Как выделить другую ячейку? Достаточно щелкнуть по ней 
мышью, причем указатель мыши в это время должен иметь вид светлого креста.  

Попробуйте выделить различные ячейки таблицы. Для перемещения по таблице 
воспользуйтесь полосами прокрутки. 

2. Для того, чтобы ввести текст в одну из ячеек таблицы, необходимо ее выделить и 
сразу же (не дожидаясь появления столь необходимого нам в процессоре Word текстового 
курсора) “писать”. 

Выделите одну из ячеек таблицы и “напишите” в ней название сегодняшнего дня 
недели. Основным отличием работы электронных таблиц от текстового процессора 
является то, что после ввода данных в ячейку, их необходимо зафиксировать, т. е. дать по-
нять программе, что вы закончили вводить информацию в эту конкретную ячейку, 

Зафиксировать данные молено одним из способов: 
• нажать клавишу (Enter}; 
• щелкнуть мышью по другой ячейке, 
• воспользоваться кнопками управления курсором на клавиатуре (перейти к 

другой ячейке).  
Зафиксируйте введенные вами данные. 
Итак, недостаточно ввести данные в ячейку, необходимо их еще и зафиксировать. 

Выделите ячейку таблицы, содержащую день недели, и воспользуйтесь кнопками 
выравнивания абзацев  Каким образом происходит выравнивание? Сделайте вывод. После 
всех экспериментов обязательно верните исходное выравнивание — влево, в дальнейшем 
это будет важно. 



3. Вы уже заметили, что таблица состоит из столбцов и строк, причем у каждого из 

столбцов есть свой заголовок (А, В, С...), и все строки пронумерованы (1, 2, 3...). Для того, 

чтобы выделить столбец целиком, достаточно щелкнуть мышью по его заголовку, чтобы 

выделить строку целиком, нужно щелкнуть мышью по ее заголовку. 

Выделите целиком тот столбец таблицы, в котором расположено введенное вами 
название дня недели. 

Каков заголовок этого столбца? 
Выделите целикам ту строку таблицы, а которой расположено название дня недели- 

Какой заголовок имеет эта строка? 
Воспользуйтесь полосами прокрутки для того, чтобы определить сколько строк 

имеет таблица и каково имя последнего столбца. 
4. Выделите ту ячейку таблицы, которая находится в  столбце С и строке 4. 

Обратите внимание на то, что в Поле имени, расположенном выше заголовка столбца А, 
появился адрес выделенной ячейки С4. Выделите другую ячейку, и вы увидите, что в 
Поле имени адрес изменился. 

Выделите ячейку D5; F2; А16. 
Какой адрес имеет ячейка, содержащая день недели? 

5. Давайте представим, что в ячейку, содержащую день недели нужно дописать 
еще и часть суток. Выделите ячейку, содержащую день недели, введите с клавиатуры 
название текущей части суток, например, "утро" и зафиксируйте данные, нажав 
клавишу {Enter}. 

Что произошло? Часть суток не "дописалась" в ячейку, а новые данные заменили 
исходные и вместо дня недели вы подучили часть суток. То есть, если выделить ячейку 
таблицы, содержащую некоторые данные и ввести новые данные с клавиатуры, в ячейке 
таблицы окажется последняя информация. 

Как же дополнить содержимое ячейки таблицы (отредактировать), не набирая заново 
все данные? Выделив ячейку, содержащую часть суток, вы увидите, что ее содержимое 
дублируется в Строке формул, расположенной выше заголовков столбцов. Именно в 
Строку формул можно щелчком мыши установить традиционный текстовый курсор, 
внести все требуемые изменения и затем зафиксировать окончательный вариант данных. 

Выделите ячейку таблицы, содержанию часть суток, установите текстовый курсор 
перед текстом в Строке формул и наберите заново день недели. Зафиксируйте данные. 
У вас должна получиться следующая картина (рис.1.1): 
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 Видно, что запись вышла за пределы своей ячейки и заняла часть соседней. Это 

происходит только тогда, когда соседняя ячейка пуста. Давайте ее заполним и 

проверим, что изменится. 

Выделите ячейку таблицы, расположенную правее ячейки, содержащей ваши данные 
(ячейку, на которую они "заехали ") и введите в нее любой текст. 

Теперь видна только та часть ваших данных, которая помещается в ячейке (рис. 1.2). 
Как просмотреть всю запись? И опять к вам на помощь придет Строка Формул. Именно в 
ней можно увидеть все содержимое выделенной ячейки. 
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рис.1.1. 

рис.1.2. 



 
 

 
 

 
 

 
 Выделите ячейку, содержащую день недели и часть суток, и просмотрите в Строке 

формул полное содержимое ячейки. Итак, Строка формул позволяет: 
• внести изменения в содержимое выделенной ячейки; 
• просмотреть содержимое ячейки, если запись не видна целиком. 
6. Как увеличить ширину столбца для того, чтобы в ячейке одновременно были видны и 

день недели, и часть суток? 
Для этого подведите указатель мыши к правой границе заголовка столбца, "поймайте" 

момент, когда указатель мыши примет вид черной двойной стрелки, и, удерживая нажатой 
левую клавишу мыши, переместите границу столбца вправо. Столбец расширился. 
Аналогично можно сужать столбцы и изменять высоту строки. 

Измените ширину столбца, содержащего день недели и часть суток таким образом, 
чтобы весь введенный текст был виден в ячейке таблицы. 

7. Часто бывает нужно выделить не одну ячейку и не целый столбец, а блок ячеек 
(несколько ячеек, расположенных рядом). 

Для этого нужно установить указатель мыши в крайней ячейке выделения и, при 
нажатой левой клавише, переместить мышь к противоположному краю выделения (весь 
выделенный блок "охвачен" рамкой, все ячейки, кроме той, с которой начали выделение, 
окрашены в черный цвет). 

Обратите внимание, что в процессе выделения в Поле имени регистрируется количество 
строк и столбцов, попадающих в выделение. В тот же момент, когда вы отпустили левую 
клавишу, в Поле имени высвечивается адрес активной ячейки, ячейки, с которой начали 
выделение (адрес активной ячейки, выделенной цветом). 

Выделите блок ячеек, начав с ячейки А1 и закончив ячейкой, содержащей "сегодня". 
Для выделения всей таблицы используйте "пустую" угловую кнопку, расположенную 

над заголовком первой строки. 
Выделите таблицу целиком. Снимите выделение, щелкнув мышью по любой ячейке. 
8. Каким образом удалить содержимое ячейки? Для этого достаточно выделить ячейку 

(или блок ячеек) и нажать клавишу {Delete} или воспользоваться командой 
горизонтального меню ПравкаОчистить. 

Удалите все свои записи. 
 

Упражнение 2 

Применение основных приемов работы с электронными таблицами: 
ввод данных в ячейку. Форматирование шрифта. Изменение ширины 
столбца. Автозаполнение, ввод формулы, обрамление таблицы, 
выравнивание текста по центру выделения, набор нижних 

индексов. 
Составим таблицу, вычисляющую n-й член и сумму арифметической прогрессии. 
Для начала напомним формулу n-го члена арифметической прогрессии: 

an=a1+d(n-l) 
и формулу суммы п первых членов арифметической прогрессии: 

Sn=(a1+an)*n/2, где a1 - первый член прогрессии, a d — разность 
арифметической прогрессии. 

На рис. 1.3 представлена таблица для вычисления n-го члена и суммы арифметической 
прогрессии, первый член которой равен -2, а разность равна 0,725. 

Перед выполнением упражнения придумайте свою арифметическую прогрессию, т. е. 
задайте собственные первый член прогрессии и разность.  



Выполнение упражнения можно разложить по следующим 
этапам. 
• Выделите ячейку А1 и введите в нее заголовок таблицы 

"Вычисление n-го члена и суммы арифметической 
прогрессии". Заголовок будет размещен в одну строчку и 
займет несколько ячеек правее А1. 

• Сформатируйте строку заголовков таблицы. В ячейку A3 
введите "d", в ячейку ВЗ - "n", в СЗ - "an". в D3 - "Sn". 

Для набора нижних индексов воспользуйтесь командой 
ФорматЯчейки..., выберите вкладку Шрифт и 
активизируйте переключатель Подстрочный в группе 
переключателей Эффекты. 
Выделите заполненные четыре ячейки и при помощи соответ-
ствующих кнопок панели инструментов увеличьте размер 
шрифта на 1 пт выровняйте по центру и примените 
полужирный стиль начертания символов. 

Строка-заголовок вашей таблицы оформлена. Можете приступить к заполнению. 
• В ячейку А4 введите величину разности арифметической прогрессии (в нашем 

примере это 0,725). 
• Далее нужно заполнить ряд нижних ячеек таким же числом. Набирать в каждой 

ячейке одно и то же число неинтересно и нерационально. В редакторах Paintbrush и 
Word мы пользовались приемом копировать—вставить. Excel позволяет еще больше 
упростить процедуру заполнения ячеек одинаковыми данными. 

Выделите ячейку А4, в которой размещена разность арифметической прогрессии. 
Выделенная ячейка окаймлена рамкой, в правом нижнем углу которой есть маленький 
черный квадрат -маркер заполнения. 

Если подвести указатель мыши к маркеру заполнения, и в тот момент, когда указатель 
мыши принимает форму черного крестика, протянуть маркер заполнения на несколько 
ячеек вниз, то весь ряд выделенных ячеек заполнится данными, расположенными в первой 
ячейке. 

Заполните таким образом значением разности арифметической прогрессии еще 
девять ячеек ниже ячейки А4. 
• В следующем столбце размещена последовательность чисел от 1 до 10. 
И опять нам поможет заполнить ряд маркер заполнения. Введите в ячейку В4 число 1, в 

ячейку В5 число 2, выделите обе эти ячейки и, ухватившись за маркер заполнения, 
протяните его вниз. 

Отличие от заполнения одинаковыми данными заключается в том, что, выделив две 
ячейки, вы указали принцип, по которому следует заполнить оставшиеся ячейки. 

• Маркер заполнения можно "протаскивать" не только вниз, но и вверх, влево или 
вправо, в этих же направлениях распространится и заполнение. Элементом 
заполнения может быть не только формула или число, но и текст. 

Можно ввести в ячейку "январь" и, заполнив ряд дальше вправо получить "февраль", 
"март", а "протянув" маркер заполнения от ячейки "январь" влево, соответственно 
получить "декабрь", "ноябрь" и т. д. Попробуйте. 

Самое главное, прежде, чем распространять выделение, выделить именно ту ячейку 
(или те ячейки), по которой форматируется заполнение. 
• В третьем столбце размещаются n-е члены прогрессии. Введите в ячейку С4 

значение первого члена арифметической прогрессии. 
В ячейку С5 нужно поместить формулу для вычисления n-го члена прогрессии, которая 

заключается в том, что каждая ячейка столбца отличается от предыдущей прибавлением 
разности арифметической прогрессии. 

Вычисление n-го 
члена и суммы 

арифметической про-
грессии 

d n an Sn 
0
 

 -2 -2 
0
 

 -1,275 -3,275 
0
 

 -0,55 -3,825 
0
 

 0,175 -3,65 
0
 

 0,9 -2,75 
0
 

 1,625 -1,125 
0
 

 2,35 1,225 
0
 

 3,075 4,3 
0
 

 3,8 8,1 
0
  

4,525 12,625 
 
 Рис. 1.3. 



Рис. 1.5. 

Рис. 1.6. 

Все формулы начинаются со знака равенства. 
Для того, чтобы ввести формулу необходимо выделить ячейку, в которую хотите 

поместить формулу, набрать знак равенства и затем набрать саму формулу со ссылками на 
соответствующие ячейки таблицы (не забудьте, что заголовки столбцов определяются 
латинскими буквами и русские А, С, В, хоть и похожи на такие же буквы латинского 
алфавита, но не являются равноценной заменой). 

Выделите ячейку С5 и наберите в ней формулу =С4+А4 (не забудьте перейти на 
латиницу, а вместо ссылки на ячейку А4 можно ввести конкретное значение разности 
вашей арифметической прогрессии). 

Можно и не набирать с клавиатуры адрес той ячейки, на которую делается ссылка. 
Набрав знак равенства, щелкните мышью по ячейке С4 и в строке формул появится ее 
адрес, затем продолжите набор формулы. В этом случае вам не нужно переключаться на 
латиницу. 

Полностью введя формулу, зафиксируйте ее нажатием {Enter}, в ячейке окажется 
результат вычисления по формуле, а в Строке формул сама формула. 

Вот проявилась и еще одна функция Строки формул: если в ячейке вы увидите 
результат вычислений по формуле, то саму формулу можно просмотреть в Строке 
формул, выделив соответствующую ячейку.  

Если вы неправильно набрали формулу, исправить ее можно в Строке формул, 
предварительно выделив ячейку. 
• Выделите ячейку С5 и, аналогично заполнению ячеек разностью прогрессии, 

заполните формулой, "протащив" маркер заполнения вниз, ряд ячеек, ниже С5. 
Выделите ячейку С8 и посмотрите в Строке формул, как выглядит формула, она 

приняла вид =С7+А7. Заметно, что ссылки в формуле изменились относительно 
смещению самой формулы. 
• Аналогично введите в ячейку D4 формулу =(-2+С4)*n/2 для подсчета суммы n 

первых членов арифметической прогрессии, где вместо -2 должен быть первый член 
вашей арифметической прогрессии. 

• Выделите ячейку D4 и заполните формулами 
нижние ячейки, протащив вниз маркер 
заполнения. 

• Теперь данными заполнены все ячейки, 
остается их только оформить. 

Все столбцы одинаковой ширины, хотя и 
содержат информацию разного объема. Можно 
вручную (используя мышь) изменить ширину 
отдельных столбцов, а можно автоматически по-
догнать ширину. 

Выделите все ячейки таблицы, содержащие 
данные (не столбцы целиком, а только блок 
заполненных ячеек без заголовка "Вычисление n-го члена и суммы арифметической 
прогрессии") и выполните команду ФорматСтолбецПодгон ширины 

Пришла пора заняться заголовком таблицы "Вычисление n-го 
члена и суммы арифметической прогрессии". 

Выделите ячейку А1 и примените полужирное начертание символов к содержимому 
ячейки. Заголовок довольно неэстетично  "вылезает" вправо за пределы нашей маленькой 
таблички.  



Выделите четыре ячейки от А1 до D1 и выполните команду ФорматЯчейки..., 
выберите закладку Выравнивание и установите переключатели в положение 
"Центрировать по выделению" (Горизонтальное выравнивание) и "Переносить по словам" 
(рис. 1.5). Это позволит расположить заголовок в 
несколько строчек и по центру выделенного блока 
ячеек. 
• Таблицу почти привели к виду образца. Если а 

этот момент выполнить просмотр 
ФайлПредварительный просмотр, то 
окажется, что остается выполнить обрамление 
таблицы. 

Для этого выделите таблицу (без заголовка) и 
выполните команду Формат-Ячейки..., выберите 
вкладку Граница, определите стиль линии и 
активизируйте переключатели Сверху, Снизу, 
Слева, Справа (рис. 1.6.). Данная процедура 
распространяется на каждую из ячеек. 

Затем выделите блок ячеек, относящихся к заголовку: от А1 до D2 и, проделав те же 
операции, установите переключатель Контур. В этом случае получается рамка вокруг всех 
выделенных ячеек, а не каждой. 

• Выполните просмотр. 
 

 
Лабораторная работа №4. (Adobe Photoshop) 

 

Быстрый эффект карандашного рисунка 
Ищите способ, как превратить фотографию в карандашный рисунок? Урок для 

начинающих покажет вам, как с помощью трёх слоёв вы сможете создать данный эффект. 
Итоговый результат 

 



 

 

 
Шаг 1 
На скриншоте ниже фотография, которую мы используем в этом уроке. Для 



получения наилучших результатов, вы должны использовать фотографию с разрешением 
примерно 6 мега пикселей или ниже (3000×2000 px). 

 
Шаг 2 
Мы создадим эффект, используя неразрушающий метод, при котором используется 

минимальное количество слоёв и который позволяет проводить дополнительную 
коррекцию в любое время. Вначале преобразуйте наше исходное изображение в Смарт-
объект (Smart Object), для этого идём Слой- Смарт-Объект – Преобразовать в смарт-
объект (Layer > Smart Objects > Convert to Smart Object). Преобразовав слой с 
изображением в смарт-объект, позволит вам применять Смарт Фильтры (Smart Object), 
настройки которых вы можете поменять в любое время. 

 
Смарт-объект (Smart Objects) можно определить по появившемуся значку в 

нижнем правом углу миниатюры слоя. 
Шаг 3 
Дважды продублируйте слой, далее, переименуйте 

слои Контур (Outline), Левые Диагональные штрихи (Left Diagonal Strokes), 
и ПравыеДиагональные Штрихи (Right Diagonal Strokes), назвав слои сверху вниз 
соответственно. 



 
Скройте видимость двух верхних слоёв, перейдите на нижний слой. 

 
Шаг 4 
Находясь на самом нижнем слое, идём Фильтр- Галерея фильтров (Filter > Filter 

Gallery).В папке Эскиз (Sketch), выберите фильтр Тушь(Graphic Pen), в 
настройках Направление штрихов (Stroke Direction), установите 
опцию По диагонали вправо (Right Diagonal), далее отрегулируйте 
настройки Длины штриха (stroke length) и Тоновый баланс (light/dark balance). Нажмите 
OK, чтобы применить выставленные значения. 

Примечание переводчика: настройки автора Длины штриха (stroke length) 15, 
Тоновый баланс (light/dark balance) 50. 



 
Шаг 5 
Включите видимость слоя Левые Диагональные штрихи (Left Diagonal Strokes), 

находясь на данном слое, повторите предыдущий шаг, но на этот раз установите 
опцию По диагонали влево (Left Diagonal).в настройках Направление штрихов (stroke 
direction). 

 
Шаг 6 
Уменьшите непрозрачность текущего слоя Левые Диагональные штрихи (Left 

Diagonal Strokes) до 50%. 



 
Результат на данный момент. 

 
Шаг 7 
Теперь мы добавим контур. Включите видимость третьего слоя Контур (Outline), 

находясь на данном слое, идём Фильтр – Стилизация – Выделение краёв (Filter > 
Stylize > Find Edges). Поменяйте режим наложения для данного слоя 
на Умножение (Multiply). На изображении появились отдельные цветовые оттенки, 
которые не очень привлекательны. Поэтому, нам необходимо избавиться от цветовых 
оттенков в следующем шаге. 



 
Шаг 8 
Вы не можете добавить фильтр Обесцветить (Desaturate) или Цветовой тон / 

Насыщенность (Hue/Saturation) прямо на Смарт-фильтр(Smart Object), тем не менее, вы 
можете добавить их в качестве корректирующих слоёв через Слои – Новый 
корректирующий слой (Layers > New Adjustment Layer). Существует ещё один 
интересный способ – это использование Стилей слоя (layer styles), чтобы обесцветить 
слой. Лично я предпочитаю данный метод, т.к. он не требует добавления дополнительного 
слоя. 

Для обесцвечивания используем Стили слоя (layer styles), применяем 
опцию Наложение цвета (Color Overlay), идём Слой – Стили слоя – Наложение 
цвета (Layer > Layer Style > Color Overlay). Установите цвет белый, серый или чёрный 
(без разницы какой цвет), далее, поменяйте режим наложения на Цветность (Color). 
Нажмите OK, чтобы применить выставленные значения, и цвета исчезнут! 

 
Мы завершили урок! Изображение будет выглядеть, как на скриншоте ниже. 

Следующий шаг является выборочным, но вы должны попробовать его выполнить, если 
вы хотите создать эффект карандашного рисунка в цвете. 



 
Шаг 9 
Чтобы цвета вновь появились, продублируйте слой Контур (Outline), далее, 

удалите стили слоя и смарт-фильтр, для этого вначале идём Слой– Стили слоя – 
Очистить стили слоя  (Layer > Layer Style > Clear Layer Styles), а затем идём Слой- - 
Смарт-фильтры - Снять смарт-фильтр (Layer > Smart Filters > Clear Smart Filters). 
Поменяйте режим наложения для данного дубликата слоя на Цветность (Color), 
переименуйте слой в “Цветность”, и мы закончили урок! 

 
Итоговый результат 

 



 
 
 

 
4. Методические материалы, определяющие 

процедуры оценивания знаний, умений, навыков 
4.1 Формы контроля уровня обученности студентов 

В процессе изучения дисциплины предусмотрены следующие формы контроля: 
текущий, итоговый контроль (зачет), контроль самостоятельной работы. 

Текущий контроль осуществляется в течение изучения дисциплины в виде 
выполнения практических заданий и устных ответов студентов на вопросы по 
пройденным темам. 

Итоговый контроль осуществляется в форме зачета в конце 2 семестра.  
Итоговая оценка предполагает суммарный учет качества выполненных 

практических заданий. 
Контроль самостоятельной работы студентов осуществляется в течение всего 

периода прохождения дисциплины. Формы контроля: педагог регулярно проверяет 
выполнение домашнего задания. Результаты контроля самостоятельной работы 
учитываются при осуществлении промежуточного контроля по дисциплине. 

4.2. Описание процедуры аттестации 
 

Процедура итогового контроля по дисциплине проходит в соответствии с 
Положением о текущем контроле успеваемости и промежуточной аттестации 
обучающихся 

- Аттестационные испытания комиссией преподавателей кафедры в составе не менее 
трех человек.  

- Информация о проведении аттестационного испытания заранее размещается в 
форме афиши или объявления. 

- На аттестацию допускаются зрители из числа желающих. 
- Оценка результатов аттестационного испытания объявляется обучающимся в день 

его проведения и выставляется в зачётные книжки не позднее следующего 
рабочего дня после их проведения. 



- Инвалиды и лица с ограниченными возможностями здоровья, имеющие нарушения 
опорно-двигательного аппарата, допускаются на аттестационные испытания в 
сопровождении ассистентов-сопровождающих. 

- Оценка результатов аттестационного испытания объявляется обучающимся в день 
его проведения.  

- 4.2 Структура зачета 
Зачет складывается из проверки практических заданий и устного ответа на вопросы 

по выполнению этих заданий.  
Знания, умения и владение предметом оценивается по дифференцированной системе 
оценки наличия основных единиц компетенции.  
  

5. Вопросы и ответы для онлайн тестирования 
 

1. Перечислите виды информационных ресурсов.  
Ответ: СМИ, электронные библиотеки, электронные базы данных, сайты, сервисы.  
 

2. Что такое информационная безопасность? 
Ответ. Это практика предотвращения несанкционированного доступа, 
использования, раскрытия, искажения, изменения, исследования, записи или 
уничтожения информации.   
 

3. Из каких частей состоит стационарный персональный компьютер? 
Ответ. Системный блок, монитор, клавиатура и мышь, дополнительные устройства 
ввода и вывода информации (принтер, сканер, колонки и т.д.) 
 

4. Что входит в понятие «периферийные устройства» ПК? 
Ответ. Это устройства, которые используются вместе с компьютером для ввода, 
вывода, хранения и обработки данных. К ним относятся клавиатуры, мыши, 
мониторы, принтеры, сканеры, внешние жесткие диски и т.д. 
 

5. Приведите примеры типов прикладного программного обеспечения, используемых 
в деятельности музыковеда. 
Ответ. Текстовые редакторы, редакторы электронных таблиц, мультимедийное 
программное обеспечение, презентационное программное обеспечение, 
образовательное программное обеспечение, и т.д. 

6. Приведите примеры названий файлов различного формата с расшифровкой типа 
файла и указанием, при помощи каких программ можно открыть данный файл (4-6 
примеров). Пример оформления ответа: name.docx (текстовый документ, 
открывается в текстовом процессоре, в частности, Microsoft Office Word) 
Ответ. Name.mp3 (аудио файл, открывается в программе-проигрывателе), name.avi 
(видеофайл, открывается в программе-видеопроигрывателе), name.xlsx 
(электронная таблица, открывается в программе excel), name.jpg (графический 
файл, открывается в программах для просмотра и редактирования графики), 
name.musx (нотный файл, открывается в нотном редакторе Finale), name.psd (файл 
проекта Adobe Photoshop, открывается в этой программе). 
 

7. Приведите примеры электронных библиотечных систем 
Ответ. ЭБС СГИИ имени Д.Хворостовского, ЭБС Лань, ЭБС  Юрайт. 
 

8. Какие типы графических редакторов вы знаете? В чем заключается их 
принципиальное различие? 



Ответ. Существуют растровые и векторные графические редакторы. Основное 
отличие заключается в типе кодирования графической информации, с которой 
работает редактор. В растровой графике изображение делится на точки – пиксели, 
каждой точке присваивается цветовое значение. В векторной графике кодируются 
не точки, а элементарные геометрические объекты (точки, линии, круги и т.п.), 
соотношение которых описывается математическими формулами. 
 

9. Для каких целей лучше применять растровые графические программы, и для каких 
– векторные? 
Растровые редакторы подходят для обработки и ретуширования фотографий, 
создания иллюстраций, коллажей, афиш, и т.д. Векторные редакторы более 
пригодны для создания логотипов, технических иллюстраций, диаграмм, 
составления блок-схем. 
 

10. Что такое шаблон документа? Какие задачи позволяет решить использование 
шаблонов? 
 
Шаблон – особый вид документа, содержащий неизменяемую часть и средства 
оформления изменяемой части. Шаблон определяет основную структуру 
документа: параметры страницы, форматирование и стили. Шаблон позволяет 
быстро создать документ с необходимыми параметрами форматирования и (при 
необходимости) с нужными текстовыми заготовками. 
 

11. Какие параметры шрифта используются в оформлении текста научной статьи, 
реферата? 
Шрифт Times New Roman, кегль 12 или 14, прямое начертание, выделение текста – 
курсивное начертание или полужирный. 
 

12. Какие параметры форматирования абзаца шрифта используются в оформлении 
текста научной статьи, реферата (в основном тексте, в заголовках)? 
 
Ответ. В основном тексте: ширина абзаца – по ширине страницы (отступы слева и 
справа 0), выравнивание по ширине, отступ первой строки 1,25 (может быть 1), 
межстрочный интервал 1 / 1,15/ 1,5; интервал до и после абзаца 0.  
В заголовках: выравнивание по центру, можно добавить интервал до и после 
абзаца. 
 

13. Для чего в текстовых редакторах используются стили заголовков? Чем эти стили 
отличаются от обычного стиля? 
Ответ. Стили заголовков используются для структурирования документа не только 
внешне, но и технически. Стили заголовков могут опираться на обычный стиль, но 
используют иной уровень абзаца (уровень 1 для Заголовок 1, уровень 2 для 
Заголовок 2 и т.д.). При использовании стилей в дальнейшем можно создать 
автособираемое оглавление, в которое будут выведены только заголовки, 
оформленные стилями. 
 

14. Перечислите разновидности Списка в текстовых редакторах 
Ответ. Маркированный список, нумерованный список, многоуровневый список. 
 

15. Приведите примеры клавишных сочетаний (с пояснением) в программе Microsoft 
Word (не менее 5) 
Ответ. Ctrl+A – выделить все, ctrl+С – копировать, ctrl + V – вставить, ctrl + X – 



вырезать, ctrl + F – найти, ctrl +B – полужирное начертание, ctrl +I – курсивное 
начертание,Ctrl + U – подчеркнутое начертание, Сtrl +У – выровнять по центру и 
т.д. 
 

16. Что такое колонтитулы и как они оформляются? 
Ответ. Колонтитулы – это части документа, которые отображаются в верхней и 
нижней части страниц документа. Колонтитулы обычно содержат дополнительную 
информацию, например, номера страниц, даты, имя автора и т.д. Для оформления 
колонтитула нужно дважды нажать левой кнопкой мыши на верхнее или нижнее 
поле. После этого откроется панель редактирования колонтитулов. 
 

17. Как создать автособираемое оглавление? 
Ответ. Для создания автособираемого оглавления необходимо всем заголовкам 
присвоить стили заголовков. После этого через вкладку Ссылки найти вкладку 
меню Оглавление и выбрать один из типов оглавления, Первый вариант оглавления 
является удобным для использования. 

 
18. Какие непечатные знаки используются в текстовых редакторах? Как они выглядят 

при включении видимости непечатных знаков? Опишите 4-6 знаков. 
Ответ. Пробелы между словами выглядят как точки по центру строки; для 
завершения абзаца используется специальный знак. Также непечатным является 
знак табуляции, который выглядит как стрелка вправо. Неделимый пробел 
выглядит как кружок. Знак перевода строки выглядит как стрелочка вниз и влево. 
Разрыв страницы обозначается текстом «Разрыв страницы» и одинарными 
строчками точек вокруг этого текста. Разрыв раздела обозначается 
соответствующим текстом, окруженным двойными строчками точек. 

 
19. Excel: что такое рабочая книга, рабочий лист, строка, столбец и ячейка рабочего 

листа? 
Ответ. Документ Excel называется рабочей книгой. Книга состоит из листов. 
Каждый лист – это отдельная таблица. Основное рабочее поле Excel состоит из 
ячеек рабочего листа. Каждая ячейка имеет адрес, которые образован именем 
столбца и номером строки, на пересечении которых расположена ячейка. 
 

20. Что такое строка формул в Excel? Какие задачи позволяет решать использование 
формул? 
Ответ.  Строка формул – это панель в верхней части окна Microsoft Excel, которая 
используется для ввода и изменения значений или формул в ячейках листа. В 
строке формул отображается значение или формула, содержащаяся в активной 
ячейке, тогда как в самой ячейке отображается результат формулы. 
  

21. Что такое Диапазон и как он оформляется в Excel? Какие задачи позволяет решить 
использование Диапазона? 
Ответ. Диапазон – это выделенная прямоугольная область прилегающих ячеек. 
Диапазоны используются в формулах для сокращения записи при использовании 
блока ячеек. В формулах диапазон записывается адресами двух крайних ячеек (в 
частности, левой верхней и правой нижней), которые разделены двоеточием. 
Например, A1:B3.  

22. Какие типы данных используются в Excel? 
Ответ. В Excel используются данные трех типов: число, текст, формула. 
 

23. Приведите примеры числовых форматов в программе Excel. 



Ответ. Общий формат, денежный формат, дата, время, процент. 
 

24. Для чего используется знак “$” в адресации ячеек? 
Ответ. Знак доллара используется для абсолютной адресации строки и/ или столбца 
в формуле, для того, чтобы при копировании формулы в другую ячейку параметры, 
отмеченные этим знаком, не менялись относительно направления копирования. 

 
25. Что такое Автозаполнение и для чего оно используется в табличном процессоре? 

Ответ. Автозаполнение – автоматический ввод одинаковой информации в таблице. 
Автозаполнение возможно от стартовой ячейки в любом направлении. При этом 
если выделить несколько ячеек, между значениями которых обнаруживается 
арифметическая прогрессия, то при автозаполнении прогрессия будет продолжена. 
 

26. Что такое функция? Какие виды функции используются в Excel? 
Ответ. Функция – последовательность математических операций, производимая 
над величинами. Функции упорядочены по категориям: логические, финансовые, 
инженерные, математические, статистические и др.  

27. Приведите примеры нотных редакторов. 
Ответ. Finale, MuseScore, Sibelius, Crescendo. 
 

28. Какие типы текста существуют в программе Finale? Приведите примеры. 
Ответ. Элементы, связанные с нотным текстом (имя нотоносца, подтекстовка под 
нотами, нюансы, партитурные буквы и т.д.), странично-ориентированный текст, 
привязанный к положению на странице (колонтитулы и свободные тексты, такие 
как заголовок, имя композитора, текст песни после нотного текста). 
 

29. С какими обозначениями в программе Finale позволяет работать инструмент Знаки 
ариткуляции (на главной панели выглядит как нота с акцентом)? 
Ответ. Инструмент позволяет набрать знаки, привязываемые к ноте и не 
предполагающие протягивания от ноты к ноте. Это штрихи, мелизмы, обозначения 
аппликатуры, обозначение педали, знаки артикуляции.  
 

30. Какие типы Умных графем (лиг и линий) можно набрать в Finale.  
Ответ. Лига простая, лига пунктирная, глиссандо, портементо, crescendo, 
decrescendo, трель, знак 
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